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 PC/Mac (5.0 and later): I’ve applied a green fill and a dashed

black stroke to a PageMaker-drawn box. I’d like the black

stroke to overlap the fill so that the spaces between the

dashes are green. Instead, I’m getting white spaces. Short

of creating two separate objects, is there a way to do this?

PageMaker always strokes an object outside the edge of the

fill. You’re right that you could get around this by removing the

stroke from the box and then positioning a separate box with a

transparent fill and the dashed stroke on top of it. However, there

is an easier way—you can use the Keyline plug-in (called Create

Keyline in PageMaker 5.x). Follow the illustrated steps below.
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Next, choose Keyline

from the PageMaker

Plug-ins submenu of

the Utilities menu (in

PageMaker 5.x, choose

Create Keyline from the

Additions submenu of

the Utilities menu).

1Select the box and

remove the stroke

from it by setting

the stroke or line

attribute to None.

In the Keyline dialog box, set the

keyline to extend 0 points outside

the object and assign the stroke or

line you want to use. This creates a

separate box with a transparent fill

and a stroke or line that overlaps

the box around the edges, positions

it on top of the filled box, and then

groups them so that they’re treated

as a single object in PageMaker.
PC/Mac: I’ve got two columns of body text, and the baselines

of the body text aren’t lining up across the columns anytime

there is a heading or subhead in the text. Is there a way to

get them to align?

Yes. Even when your body text is aligned at the tops of adja-

cent columns, specially formatted paragraphs (such as headings)

can disrupt the alignment of any text that follows. The best way to

ensure that text aligns across multiple columns is to base your

layouts on a leading grid and then adjust the attributes of para-

graphs that get out of line. Leading grids are based on the leading

value assigned to your body text and are measured from the top
of each text block. They provide the framework that ensures that

the baselines of text align across multiple columns.

PageMaker’s Align to Grid feature helps ensure that specially

formatted paragraphs don’t cause your layout to get out of

whack, but you’ll have to establish the leading grid yourself. Here

are some tips for using Align to Grid and other features to make

sure your baselines align.

Establishing a grid is your first task, and the best way to do so is

to assign a fixed leading amount (for example, you might use a

leading value of 12 for 10-point body copy) to all body-copy

styles. While you can use PageMaker’s auto leading if you’re will-

ing to do a little math (you’ll need to calculate the exact leading

value PageMaker uses), using a grid is easier if you use a specific,

fixed leading value for body copy.

The next step is to make sure that the tops of the text blocks

are also on the grid. If the tops of the text blocks align, you can

position them using ruler guides (PageMaker 6.5’s Grid Manager

plug-in makes it easy to create grids of ruler guides). Another ap-

proach that takes the grid idea a step further is to customize

PageMaker’s vertical ruler to reflect the leading grid by choosing

General from the Preferences submenu of the File menu in Page-

Maker 6.5 (in earlier versions, choose Preferences from the File

menu). Select Custom from the Vertical Ruler pop-up menu, and

then enter the leading value into the text box. This uses the unit

of your leading grid for PageMaker’s vertical ruler, so aligning ob-

jects to the grid is easier.

Once the tops of the text blocks align to the grid, and the body

copy within each text block uses the leading-grid value, you’re

nearly finished. All that remains, actually, is to identify and correct

the paragraph attributes of any unruly, off-the-grid paragraphs.

This is where Align to Grid comes in handy. Select the misaligned

paragraph (or better yet, edit the paragraph’s style) and choose

Paragraph from the Type menu. In the Paragraph Options dialog

box, click Rules, and then click Options to open the Paragraph

Rule Options dialog box. Select Align Next Paragraph to Grid, and

then enter the leading value you are using for your body text for

the Grid Size option. After entering the Grid Size, click OK to close

each dialog box. Repeat these steps for each paragraph or style

that causes misalignment, and the baseline of your text should

align across columns.

For more information about using grids, see “Get the Lead In”

by Tim Cole, Adobe Magazine, May/June 1995, page 55.

PC/Mac (6.0 and later): I get font substitution when I view

a PDF I created from PageMaker on a computer that doesn’t

have the fonts that I used installed. I thought that if I se-

lected Include Downloadable Fonts in the Export Adobe PDF

dialog box, I wouldn’t have to worry about font substitution.

What’s happening?

To avoid font substitution when your PDF is viewed on a com-

puter that doesn’t have the fonts used in the publication, you’ll

need to embed the fonts within the PDF. The Include Down-

loadable Fonts option in the Export PDF dialog box includes the

fonts in the PostScript file used to create the PDF, but it doesn’t

embed the fonts in the PDF itself. (Generally, you would use In-

clude Downloadable Fonts only if you plan to distill the file on a

computer that doesn’t have the fonts you’re using in the Page-

Maker file. If you plan to distill the PostScript file on the machine

where it was created, it’s not necessary to select this option.)
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Tip: Mac

Micro Tip:

New Go Back and

Go Forward com-

mands (on Page-

Maker 6.5’s Layout

menu) allow you to

retrace your steps

through a publica-

tion, much like you

would in a browser.
To embed fonts in the PDF files you create from PageMaker,

select Override Distiller Options in the Export Adobe PDF dialog

box, and then click Edit. In the Distiller PDF Job Options dialog

box, select Embed All Fonts. This option ensures that you won’t

get font substitution, but embedding fonts increases the PDF

file’s size. In PageMaker 6.5, one way to minimize file size when

embedding fonts is to select the Subset Fonts Below option so

that only those characters that are used are embedded. By de-

fault, if more than 25 percent of the characters in a font are used,

the whole font will be included. Entering a larger value for this

option means a larger subset of the font will be embedded in the

PDF file, taking up less space than the entire font. Adobe Acrobat

Distiller offers even more control over font-embedding options;

refer to your Adobe Acrobat Distiller documentation for details.

PC/Mac (6.0 and later): I’ve got hundreds of documents

that I need to convert from PageMaker 5.0 to PageMaker

6.5 format. As I’ve needed them, I’ve opened each one and

saved it from PageMaker 6.5. Is there an easier way to con-

vert numerous files?

Use the Publication Converter plug-in. Not only can it convert

multiple PageMaker publications at once, but it can also search

your entire hard drive (as well as any other network volumes con-

nected to your computer) for older PageMaker files and auto-

matically convert them to PageMaker 6.x format. If you’d like, you

can also have the Converter run a PageMaker script on each of the

files as they’re converted (to change Preference settings, for ex-

ample). To use the plug-in, choose Publication Converter from the

Plug-ins submenu of the Utilities menu.

The Publication Converter plug-in can convert documents

from versions as far back as PageMaker 4.0. If you’ve got even

older documents, you can convert them into PageMaker 4.0 for-

mat using the stand-alone PageMaker 3.x Converter, and then use

the Publication Converter to update them to PageMaker 6.5. The

PageMaker 3.x Converter is included on the PageMaker 6.5 CD;

you can also download a copy from Adobe’s Web site at www.

adobe.com/supportservice/custsupport/download.html.
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PC/Mac (6.5 only): After I import an EPS graphic into Page-

Maker 6.5, my publication becomes really huge. I’m not em-

bedding the EPS in the document. Any idea as to what could

be going on here?

When you import an EPS graphic that doesn’t have a preview,

PageMaker 6.5 generates one—on the fly—and stores it within

the publication; depending on your Preview Option settings,

these previews can dramatically increase your publication’s file

size. While you don’t need any preview for an EPS file to print cor-

rectly on a PostScript printer, non-PostScript devices use the pre-

view (rather than the PostScript commands contained in the file)

to print the image. This feature means you’re able to get reason-

able results printing EPS files—even those without previews,

which displayed and printed as gray boxes in previous versions—

to non-PostScript printers.

The Preview Options in the EPS Import Filter v2.2 dialog box—

and the dimensions of your EPS—determine how much space a

preview requires. Fortunately, you can make a trade-off between

the quality of a preview and its size. By reducing the Preview

Resolution and lowering the Color Depth setting, you can de-

crease your publication’s file size by shrinking the size of Page-

Maker’s EPS previews.

After you’ve selected

an EPS file in the Place

Document dialog box,

check Show Filter Pref-

erences or hold down

the Shift key as you click

OK to display the EPS

Import Filter dialog box.

By default, the Resolu-

tion is set to 72 dpi for

PageMaker for the Macintosh. In PageMaker 6.5 for Windows the

Resolution default is 300 dpi, so you’re more likely to see large file

sizes. Decrease the Resolution setting to get a smaller—but

chunkier-looking—preview. To decrease the preview size further,

select 256 Colors for the Color Depth setting, which takes two to

three times less space than selecting Millions of Colors. Olav Mar-

tin Kvern’s “Desktop Science” column (page 63) provides addi-

tional information about PageMaker’s ability to create previews

for EPS files.

PC/Mac (6.5 only): I’m printing color separations from a

PageMaker publication, and I’ve found that some of the

text prints at the wrong point size. However, when I print

the document as a composite, everything prints okay.

Any idea as to what could be going wrong here?

Yes. An error in the way PageMaker generates trapped color

separations causes the point size of the second piece of colored

text in a text block to default to the size of the first instance. Be-

cause trapping isn’t used when printing composites, they—and

separations printed without trapping—will print correctly. Here

are some ways to avoid the problem.

• Force PageMaker to recompose the text (and thus use the

proper point size when printing trapped color separations) by

changing the attributes of the text immediately preceding the

second instance of colored text. Insert a thin space before the

second instance of colored text and decrease its size by a frac-

tion of a point.
Exporting to HTML
To export an object that won’t ordinarily translate to HTML,

such as a PageMaker-drawn object, or a headline you want

to display in a particular font, cut the object, and then choose

Paste Special from the Edit menu. Then select PICT in the Paste

Special dialog box. This pastes the object back into PageMaker

as a PICT image;

when you export

HTML from your

publication, the

PICT image is

automatically ex-

ported as a Web-

compatible GIF

or JPEG graphic.



Select the Approxi-

mate Layout option

if you want the HTML

documents you

export to look like

the PageMaker pub-

lication they were

exported from.

PhotoD
isc
• Another solution is to split the colored text into two separate

stories, because PageMaker calculates text attributes on a

story-by-story basis. For instructions, see page 116 in the Page-

Maker 6.5 User Guide.

• Alternatively, you won’t encounter this problem if you print

from Luminous TrapWise, which has the added advantage of

being able to trap the graphics included in your publication

(PageMaker’s trapping works only on text and PageMaker-

drawn graphics).

By the time you read this, there may be an update available to

correct the problem. Check Adobe’s Web site at www.adobe.com

for details.

PC/Mac (6.0 and later): I’ve got a PageMaker document I’d

like to publish on the Web. However, the HTML I exported

from PageMaker doesn’t look much like my original pub-

lication. How can I get better results?

There are several things you can do. But first, it’s important to

understand that the limitations of HTML affect PageMaker’s abil-

ity to generate HTML files that match your original publication.

While HTML offers exciting features not currently available in

page-layout programs, it has much more limited formatting and

layout capabilities than PageMaker does. Translating the com-

plexity of a PageMaker 6.x document—often with multiple lay-

ers, sophisticated typography, and graphically rich content—into

HTML, in which many of these features have no real equivalent,

presents a real challenge. FaxYI document 116214 covers these

differences in detail for PageMaker 6.5, and Chapter 13 of the

PageMaker 6.0 and 6.5 User Guides is another good source for in-

formation about this process.

PageMaker 6.5 delivers significant improvements to the HTML

export feature. Using HTML tables, PageMaker can control how

objects are positioned in the exported HTML file. PageMaker

defines the cells in each table based on the size and position of

objects in your publication, so your HTML document looks a lot

more like your publication. To use this feature, choose HTML from

the Export submenu of the File menu. In the HTML Export dialog

box, click Options. In the Options dialog box, select the Approxi-

mate Layout Using HTML Tables When Exporting Pages option.

If a particular object ends up in the wrong place in the HTML

file, and you have Approximate Layout selected, it’s probably be-

cause the object overlaps something else in the PageMaker publi-

cation. When objects overlap, PageMaker must reposition one or

more of them when exporting the HTML file. To correct the prob-

lem, adjust the objects in your PageMaker publication so that

they don’t overlap, and then re-export the file.

Mac (5.0 and later): I’ve heard that if I have a problem

printing something from PageMaker to a PostScript printer,

I should try holding down the Option key before choosing

Print from the File menu. What exactly does this do?

Choosing Option + Print from PageMaker uses the PostScript

driver selected in the Chooser (such as the PSPrinter or Laser-

Writer 8 drivers) instead of PageMaker’s internal PostScript en-

gine to generate the PostScript code used to print your publica-

tion. High-end graphics applications such as PageMaker generate

their own optimized PostScript in order to achieve the best re-

sults possible. In most cases, it’s preferable to use PageMaker’s in-

ternal PostScript engine. Sometimes, though, PageMaker runs
into trouble printing an element—and in a pinch using a differ-

ent PostScript driver may enable you to work around the problem

and print your publication.

Here’s a little background information on these two printing

methods. When you print normally from PageMaker, your publi-

cation is translated directly into PostScript, which is then passed

through the Chooser-level driver. In contrast, when you choose

Option + Print, QuickDraw (a system-level display and printing

language) commands are sent to the driver, and are then con-

verted to PostScript. Generally, QuickDraw isn’t as robust a page-

description language as PostScript is; by filtering everything

through QuickDraw, you limit PostScript to what QuickDraw can

do. For many publications printed on desktop laser printers,

there’s no visible difference. But when you’re printing at high

resolutions, printing color separations, or post-processing the file,

using Option + Print is likely to cause problems. We recommend

using Option + Print only as a last resort. ◆
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